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WHERE ARE THE LESSON FILES?
Purchase of this Classroom in a Book in any format gives you access to the lesson fi les you’ll 
need to complete the exercises in the book.

1 Go to peachpit.com/PremiereProCIB2025.

2 Sign in or create a new account.

3 Click Submit.

4 Answer the question as proof of purchase.

5 Th e lesson fi les can be accessed through the Registered Products tab on your Account page.

6  Click the Access Bonus Content link below the title of your product to proceed to the down-
load page. Click the lesson fi le links to download them to your computer.

• Note: If you encounter problems registering your product or accessing the lesson fi les or web 
edition, go to peachpit.com/support for assistance.

• Note: If you purchased a digital product directly from peachpit.com, your product will already be 
registered. Look for the Access Bonus Content link on the Registered Products tab in your account.

http://peachpit.com/PremiereProCIB2025
http://peachpit.com/support
http://peachpit.com


Important!
The video clips and other media files provided with this book are practice files, 
provided for your personal, educational use in these lessons only. You are not 
authorized to use these files commercially or to publish, share, or distribute them in 
any form without written permission from Adobe Inc., and the individual copyright 
holders of the various items. Do not share videos created with these lesson files 
publicly. This includes, but is not limited to, distribution via social media or online 
video services including YouTube and Vimeo. You will find a complete copyright 
statement on the copyright page at the beginning of this book.

Thanks to Patrick Cannell for the music “Ambient Heavens,” copyright © Patrick 
Cannell.

Thanks to Patrick Cannell for the music “Cooking Montage,” copyright © Patrick 
Cannell.

Thanks to Luisa Winters at MidAtlanticDrones.com for Valley Of Fire footage, 
copyright © Maxim Jago.

Footage from Andrea Sweeney NYC, copyright © Maxim Jago.

Footage from Laura in the Snow, copyright © Maxim Jago.

Footage from Theft Unexpected, copyright © Maxim Jago.

Footage from She, copyright © Maxim Jago.

http://MidAtlanticDrones.com
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ADDING TRANSITIONS

Lesson overview
In this lesson, you’ll learn how to do the following:

• Understand edit points and handles.

• Understand transitions.

• Add video transitions.

• Modify transitions.

• Fine-tune transitions.

• Apply transitions to multiple clips.

• Work with audio transitions.

This lesson will take about 75 minutes to complete. To get the lesson files 
used in this lesson, download them from the web page for this book at 
peachpit.com/PremiereProCIB2025. For more information, see “Accessing 
the lesson files and Web Edition” in the “Getting Started” section at the 
beginning of this book. Store the files on your computer in a convenient 
location.

7

http://peachpit.com/PremiereProCIB2025
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Transitions can help create a seamless fl ow between 
two video or audio clips or inform the viewer that 
a change of scene has begun. Video transitions are 
often used to signify a change in time or location. 
Audio transitions provide a useful way to avoid abrupt 
edits that jar the listener or to blend the signifi cance 
of two scenes.
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Starting the lesson
Although the most common transition is a cut—where one clip abruptly ends and 
another begins—there are great opportunities for creativity using transition effects 
you can animate.

In this lesson, you’ll learn to use transitions between video and audio clips to help 
your edits flow more smoothly. You’ll also learn best practices for choosing the most 
appropriate transitions.

For this lesson, you’ll use a new project file.

1 Start Adobe Premiere Pro, and open the project Lesson 07.prproj from the 
Lessons folder.

2 Use the Workspaces menu to choose Effects. Reset the workspace to the saved 
layout.

This changes the workspace to a preset optimized for working with transitions 
and effects. In particular, the Effects panel is now in the upper-right corner with 
the Properties panel beneath it.

In the Effects panel, you can click any effect category’s triangle to display its 
contents.

3 Save the project as Lesson 07 Working.prproj in the same folder.

Because most effects are applied to clips in sequences, the Source Monitor is 
now hidden in its panel group and the Effect Controls panel has been brought to 
the front.

l Note: To ensure 
that the tools function 
and the defaults are set 
exactly as described in 
this lesson, reset the 
Premiere Pro prefer-
ences by holding the 
Option (macOS) or 
Alt (Windows) while 
launching the applica-
tion and then clicking 
Continue in the Reset 
Options dialog box.
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What are transition effects?
Adobe Premiere Pro offers several special effects and preset animations to help you 
bridge neighboring clips in a sequence. These transitions—such as dissolves, wipes, 
dips to color, and so on—provide a way to ease viewers from one scene to the next. 
As well as smoothing the join between two clips, transitions can be used to focus 
attention on a major jump in the story.

Choosing and configuring transitions is an art. Applying them is simple enough: 
Drag the transition you want from the Effects panel onto the edit point between two 
clips in a sequence. The skill comes in their placement, length, and settings, such as 
direction, motion, and start/end positions.

You can adjust some transition settings in the Timeline panel, but it’s usually easier 
to make precise adjustments in the Effect Controls panel. To view the settings for a 
transition effect in the Effect Controls panel, select it in a sequence.

In addition to the unique options for each transition, the Effect 
Controls panel features a helpful A/B timeline display (more on 
this later).

This display makes it easy to change the timing of transitions 
relative to an edit point, change the transition duration, and apply 
transitions to clips that don’t have enough head or tail frames—
that is, additional content to provide an overlap at the beginning (head) or end (tail) 
of a clip.

Knowing when to use transitions
Transitions are a standard storytelling tool in video editing, and the rules for their 
use are similar to the rules of screenwriting. They’re effective when they help the 
viewer understand the story.

For example, you may switch from indoors to outdoors in a video, or you may jump 
forward in time. An animated transition, a fade to black, or a dissolve can help the 
viewer understand that the location has changed, that time has passed, or that a 
character’s perspective has changed.

A fade to black at the end of a scene is a clear indication that the scene has fin-
ished. The trick with transitions is to be intentional—and this often means using 
restraint—unless, of course, a total lack of restraint is the creative result you want!

As long as it looks like you intended to include a particular effect, your audience will 
tend to trust your decision (whether or not they agree with your creative choice). 
It takes practice and experience to develop sensitivity for the right time, and the 
wrong time, to use effects such as transitions. If in doubt, less is usually best.

There is an established visual language that modern audiences recognize and 
respond to. For example, if a character falls asleep and the picture goes soft-focus, 



186 LESSON 7 Adding Transitions

with everything in the frame glowing and bright, your audience will immediately 
know that we are witnessing that character’s dream. Studying this kind of visual 
language can help you make creative choices.

Following best practices with transitions
You may be tempted to use a transition effect on every cut. Don’t! Or at least get 
them out of your system with your first project.

Most TV shows and feature films use cuts-only edits. You’ll rarely see any transi-
tion visual effects. Why is this? An effect should be used only if it gives an additional 
benefit; transition effects can sometimes be a distraction from the video, remind-
ing viewers they are watching a story and preventing them from connecting with it 
emotionally.

If a news editor uses a transition effect, it’s for a purpose. The most frequent use in 
newsroom editing is to transform what would have been a jarring or abrupt edit into 
a more comfortable experience.

A jump cut is a good example of a scenario where a transition effect can help. A 
jump cut is a cut between two similar shots. Rather than looking like a continua-
tion of the story, they look a little like a piece of the video is unintentionally missing. 
By adding a transition effect between the two shots, you can make a jump cut look 
intentional and less distracting.

Dramatic transition effects do have their place in storytelling. Consider the Star 
Wars movies with their highly stylized transition effects, such as obvious, slow 
wipes. Each of those transitions has a purpose. In this case, it’s to create a look remi-
niscent of old serialized movies and TV shows. The transition effects send a clear 
message: “Pay attention now. We’re transitioning across space and time.”

Understanding the importance 
of clip handles
To understand transition effects, you’ll need to understand edit points and handles. 
An edit point is the point in your sequence where one clip ends and the next begins. 
This is often called a cut and sometimes simply called an edit. These are easy to see 
because Premiere Pro displays vertical lines to show where one clip segment ends 
and another begins (much like two bricks next to each other). By default, a thumb-
nail shows the first frame of each clip.
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Before you first edit a clip into a sequence, you set an In point and an Out point to 
select the part you want to use. When you edit that selected part of the clip into a 
sequence, the unused sections at the beginning and end are still available but hid-
den in the Timeline panel. Those unused sections are referred to as clip handles or 
simply handles.

There’s a handle between a clip’s original beginning and the In point you set. There’s 
also a handle between a clip’s original end and the Out point you set. The time ruler 
in the Source Monitor shows you how much footage is available in your handles.

Playhead position In/Out duration

Original 
start

Original 
end

Handle Out pointIn point Handle

Of course, you may not have used In or Out points, or you may have set just an 
In point or an Out point at the very beginning or end of the clip. In this case, you 
would have either no unused media or unused media at only one end of the clip.

In the Timeline panel, if you see a tiny triangle in the upper-right or upper-left 
corner of a clip, it means you’ve reached the end of the original clip and there are no 
additional frames available.

No handle No handle No handleHandle available

For transition effects to work, you need handles because the effect creates an over-
lap between the outgoing clip and the incoming clip.

For example, if you want to add a two-second Cross Dissolve transition centered 
between two video clips, you need at least a one-second handle available on 
both clips (one additional second each that would not normally be visible in the 
sequence). In the Timeline panel, the transition effect icon gives a visual indication 
of the duration of the effect and, therefore, the clip overlap.
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Adding video transition effects
Premiere Pro gives you multiple video transition effects to choose from. Most 
options are available in the Video Transitions group in the Effects panel.

Video transitions are organized into seven subcategories. You’ll find some additional 
transitions in the Video Effects > Transition group in the Effects panel. However, 
these effects are meant to be applied to an entire clip and are used to reveal the 
visual contents of the clip over time between its start and end frames (not using clip 
handles overlapping another clip). This second category works well for superimpos-
ing text or graphics.

Applying a single-sided transition
The easiest transition to understand is one that affects just one end of a single clip. 
This could be a fade from black on the first clip in a sequence or a dissolve into an 
animated graphic. Let’s give it a try.

1 If it’s not already open, open the sequence called Transitions.

This sequence has four video clips and background music. The clips have handles, 
so transition effects can be applied between them (no tiny triangles are visible at 
the ends of the clips, which would indicate the last frame is already visible).

2 In the Effects panel, open the Video Transitions > Dissolve group. Find the Cross 
Dissolve effect.

3 Drag the effect onto the start of the first video clip. A highlight shows you where 
the transition effect will be added. When the transition is in the right position, 
release it.

4 Drag another Cross Dissolve effect onto the end of the last video clip.

l Note: You can use 
the Search field, at the 
top of the Effects panel, 
to locate an effect by 
name or keyword, or 
you can browse the 
folders of effects.
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The Cross Dissolve icon shows the timing of the effect. For example, the effect 
you just applied to the last clip in the sequence will start before the end of the 
clip and complete by the time it reaches the clip’s end.

Transitions of this kind don’t extend the clip (using a handle) because the transi-
tion doesn’t reach past the end of the clip.

Because you’re applying the Cross Dissolve transition effect at the end of the 
last clip, where there is no connected clip, the picture dissolves into the back-
ground of the Timeline, which is black. The result is that this looks like a Dip To 
Black effect.

In reality you are causing the clip to become gradually transparent in front of a 
black background. The difference is clearer when you work with multiple layers 
of clips, with different-colored background layers.

5 Play the sequence to see the result.

You should see a fade from black at the start of the sequence and a fade to black 
at the end.

Applying a transition between two clips
Let’s apply transitions between a few clips. For the purposes of exploration, you’ll 
break the less-is-best rule and try several options in one sequence. As you go 
through these steps, play the sequence regularly to view the results.

1 Continue working with the previous sequence, called Transitions.

2 Move the Timeline playhead to the edit point between clip 1 and clip 2 and 
then press the equal sign (=) key two or three times to zoom in fairly close. If 
your keyboard does not have the = key, use the navigator at the bottom of the 
Timeline panel to zoom. You can also create a custom keyboard shortcut for this 
purpose (see Lesson 1, “Touring Adobe Premiere Pro”).

 Tip: On an English-language keyboard, it’s easy to remember that pressing the = key (if your 
keyboard has one) zooms in because there is usually a + symbol on the same key.

3 Drag the Dip To White transition effect from the Dissolve group in the Effects 
panel onto the edit point between the first clip and the second clip. The effect 
will snap to one of three positions, and the pointer will change to indicate which 
position the transition will occupy.
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Be sure to line up the effect with the middle of the edit, not the end of the first 
clip or beginning of the second clip.

The Dip To White transition effect gradually builds to a completely white screen, 
which obscures the cut between the first clip and the next.

4 In the Effects panel, click the triangle for the Slide group of video transitions to 
display its contents. Drag the Push transition onto the edit point between the 
second clip and the third clip in the sequence, centered on the cut.

5 Play through the transition to see the result, and then position the playhead on 
the edit between clip 2 and clip 3 by pressing the Up Arrow key. The Up and 
Down Arrow keys are shortcuts to move the Timeline playhead to the previous 
or next edit on targeted tracks.

 Tip: Keyboard shortcuts are usually panel-specific. If the arrow keys don’t move the play-
head, check that the Timeline panel is active, with a blue outline.
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6 Click the Push transition effect icon in the Timeline panel once to select it.

7 In the Effect Controls panel, change the direction of the clip from West To East 
to East To West by clicking the small direction control triangle to the right of the 
A/B thumbnail at the top left of the Effect Controls panel.

Select directionSelect direction

Select direction

Select direction

Each small white triangle changes the direction for the Push transition effect. 
Hover the pointer over a triangle to see a tool tip describing the option.

In the Timeline panel, play through the transition to see the result.

8 In the Effects panel, expand the Page Peel group in the Video Transitions cat-
egory. Drag the Page Turn transition effect onto the edit point between the third 
clip and the fourth clip, centered on the cut.

9 Review the sequence by playing it from beginning to end.

Having watched this sequence, you can probably see why it’s a good idea to use 
transitions with restraint!

Let’s try replacing an existing transition effect.

10 Drag the Barn Doors transition from the Wipe group onto the existing Push 
transition effect icon, between the second clip and the third clip. The new transi-
tion effect replaces the old one, taking the duration and timing of the existing 
effect.

11 Select the Barn Doors transition effect icon on the timeline so its settings are dis-
played in the Effect Controls panel. Using the controls in that panel, set Border 
Width to 7 to create a thin black border at the edge between the two clips.

l Note: You may need to scroll down in the Effect Controls panel to access further controls.

12 Play through the transition to view the result. The best way to do this is prob-
ably to click a little earlier in the sequence to watch the video leading up to the 
transition.

Tip: If the Effect 
Controls panel is empty 
when you open it, 
click once on the Push 
transition effect again 
to re-select it.

l Note: When you 
drag a new video or 
audio transition effect 
from the Effects panel 
on top of an existing 
transition, it replaces 
the existing effect. 
It also preserves the 
alignment and dura-
tion of the transition it 
replaces. This is a quick 
way to experiment with 
alternative transition 
effects.
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If the video does not play smoothly during transition effects, press the Return 
(macOS) or Enter (Windows) key to render, wait for the rendering to complete, 
and try again. See the sidebar “Red, yellow, and green render bars” later in this 
lesson for more information about rendering.

Video transitions have a default duration, which can be set in seconds or frames 
(it’s frames by default). If the default duration is set in frames, the effective play-
back duration of a transition effect will change depending on the sequence frame 
rate. The default transition duration can be changed in the Timeline section of 
the Preferences panel.

13 Choose Premiere Pro > Settings > Timeline (macOS) or Edit > Preferences > 
Timeline (Windows). Depending on your geographic region, you may see a 
Video Transition Default Duration setting of 30 Frames or 25 Frames.

14 This is a 24-frames-per-second sequence, but this doesn’t matter if you change 
the Video Transition Default Duration option to 1 second. Do so now, and 
click OK.

Existing transition effects keep their existing settings when you change the pref-
erence, but any future transitions you add will have the new default duration.

The duration of an effect can dramatically change its impact, and later in this 
lesson, you’ll learn about adjusting the timing of transitions.
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Applying the default transition effect to multiple clips
So far, you’ve been applying transitions to video clips. You can also apply transitions 
to still images, graphics, color mattes, and even audio, as you’ll see shortly.

It’s common for editors to create a photomontage, which might look good with 
transitions between the multiple photos. Applying transitions between two or three 
photos is quick and easy, but if you have 100 images, it will take a long time!

Premiere Pro makes it straightforward to automate this process by allowing you to 
set a default transition effect.

1 In the Project panel, find and open the sequence Slideshow.

This sequence consists of several images placed in a particular order. Notice that 
a Constant Power audio crossfade has already been applied to the beginning and 
end of the music clip to create a fade in and out.

2 Play the sequence by making sure the Timeline panel is active and pressing 
the spacebar.

There’s a cut between each clip.

3 Press the backslash (\) key to zoom out the Timeline panel so the whole 
sequence is visible. If your keyboard does not have a \ key, drag the right end of 
the Timeline panel navigator to adjust the zoom.

4 If necessary, increase the height of the V1 track to see thumbnails on the clips 
(you can drag the dividing line between V1 and V2 in the track header).

5 Using the Selection tool, draw a marquee around all the video clips to select 
them. Begin dragging in an empty area, away from the clips, or you’ll move the 
first clip you click instead.

6 Choose Sequence > Apply Default Transitions To Selection.

This applies the default transition between all the currently selected clips. 
Notice that the Constant Power audio crossfades at the beginning and end of 
the music clip are now shorter because the default audio transition duration has 
been applied.

Tip: If you discover 
a useful keyboard 
shortcut that uses a key 
not included on your 
keyboard, you can use 
the Keyboard Shortcuts 
dialog box to assign a 
different key.

Tip: You’ll find the 
option to apply audio-
only or video-only 
transition effects in the 
Sequence menu too.

l Note: If you’re work-
ing with clips that have 
linked video and audio 
and Linked Selection is 
enabled in the Timeline 
panel, you can select 
just the video or audio 
portions by Option-
dragging (macOS) or 
Alt-dragging (Windows) 
with the Selection 
tool. Then choose 
Sequence > Apply 
Default Transitions To 
Selection.



194 LESSON 7 Adding Transitions

The default video transition effect is a 30-frame or 25-frame Cross Dissolve 
(though you changed this earlier to 1 second), and the default audio transition 
effect is a 1-second Constant Power crossfade. The shortcut you used replaced 
the existing audio crossfades with new, shorter ones.

You can set the default transition by right-clicking any transition effect in the 
Effects panel and choosing Set Selected As Default Transition. The icon for the 
selected default transition effect has a blue outline.

7 Play the sequence to see the difference the new Cross Dissolves make to the 
montage.

Copying a transition effect to multiple edits
You can copy an existing transition effect to multiple edits using the keyboard.

Let’s try it.

1 Press Command+Z (macOS) or Ctrl+Z (Windows) to undo the last step, and 
press Esc to deselect the clips.

2 Select any transition effect in the Effects panel, and drag it onto the cut between 
the first two video clips in the Slideshow sequence.

3 You can change the length of any transition by dragging its edge in the Timeline. 
Drag one end of the transition you just applied to make it longer.

4 Select the transition by clicking its effect icon once in the sequence.

5 Press Command+C (macOS) or Ctrl+C (Windows) to copy the effect. Then hold 
Command (macOS) or Ctrl (Windows) while you use the Selection tool to drag a 
marquee around multiple other edits to select them, rather than clips.

6 With the edits selected, press Command+V (macOS) or Ctrl+V (Windows) to 
paste the transition effect onto all the selected edits.

This is a great way to add transition effects with matching settings to multiple edits, 
especially if you have taken the time to customize the effect.
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Red, yellow, and green render bars
When you add a transition to a sequence, a red or yellow horizontal line (or render 
bar) may appear above it in the Timeline panel. A yellow bar indicates that Premiere 
Pro expects to be able to play the effect smoothly. A red bar means that this section 
of the sequence may need to be rendered before you can play a preview without 
dropped frames.

You can choose to render 
at any time to make these 
sections preview more 
smoothly on a less powerful 
computer.

The easiest way to render 
is to press the Return/Enter 
key. If you add In and Out points to select a part of your sequence and then render, 
only the selected section of the sequence will render. This is useful if you have many 
effects that need to render but you’re concerned with only one part for now.

Red or yellow bars will turn to green when those sections of a sequence are 
rendered. Premiere Pro creates a video file for each section where the bar has 
turned green. The new video files are stored in the Preview Files folder (as set in the 
project’s Scratch Disk settings). As long as the render bar is green, playback should 
be smooth.

Using A/B mode to fine-tune a transition
When you review transition effect settings in the Effect Controls panel, you have 
access to an A/B editing mode that splits a single video track into two. What would 
normally be displayed as two consecutive and contiguous clips on a single timeline 
track are now displayed as individual clips on separate tracks, with a transition 
between them. Separating the elements of the transition in this way allows you to 
manipulate the head and tail frames (or handles) and to change other transition 
options.

Changing parameters in the Effect Controls panel
You can customize all transitions in Premiere Pro. A major benefit of the Effect 
Controls panel is that, in addition to it giving you access to the settings for transition 
effects, you can see the outgoing and incoming clip handles (unused media in the 
original clip). This makes it easier to adjust the timing of an effect.

Let’s modify a transition.
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1 In the Timeline panel, switch back to the Transitions sequence.

2 Position the Timeline playhead over the Barn Doors transition you added 
between clips 2 and 3, and click the transition to select it.

3 In the Effect Controls panel, select the box for Show Actual Sources. This 
updates the preview thumbnail to show the result of the effect.

4 In the Effect Controls panel, open the Alignment menu, and choose Start At Cut.

The transition in the Effect Controls panel timeline, and in the sequence, 
switches to show the new position.

5 Click the small Play The Transition button  at the upper-left corner of the 
Effect Controls panel to preview the transition beneath the button.

6 Now change the transition duration. In the Effect Controls panel, click the blue 
numbers for the Duration, type 300, and click away from the numbers or press 
the Tab key to apply the new setting. Premiere Pro will add the correct punctua-
tion automatically, changing 300 into 00:00:03:00—that is, 3 seconds.

The Alignment menu changes to Custom Start because the effect now reaches 
beyond the beginning of the next transition effect. To make the new transition 
duration fit, Premiere Pro automatically sets its start two frames earlier.

Examine the A/B timeline display in the Effect Controls panel timeline, at the 
right side of the panel. There is a zoom navigator at the bottom of the Effect 
Controls panel timeline that works just like the one in the Monitors and Time-
line panel. Zoom out by dragging one of the circles on the navigator to make it 
longer, so you can see the ends of the clips.

l Note: If the Effect 
Controls panel timeline 
is not visible, click 
Show/Hide Timeline 
View at the upper-right 
corner of the panel. You 
may need to resize the 
panel to make the but-
ton visible.

l Note: It’s possible to 
shorten a transition to a 
duration of one frame. 
This can make it hard to 
grab and position the 
transition effect icon, so 
try using the Duration 
and Alignment controls. 
If you want to remove 
a transition, select it 
in the sequence in the 
Timeline panel and 
press Delete (macOS) or 
Backspace (Windows).
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In this example, the Effect Controls panel timeline shows the cut between 
the two clips, and you can see the way the effect timing has been adjusted 
automatically.

7 In the Timeline panel, play through the transition to see the change.

These automated adjustments can be subtle, so always double-check the results 
of new settings by playing through the effect. That way, you can be sure you’re 
happy with the newly revealed media taken from the clip handles—the media 
that was hidden from view until you added the transition effect. Although it’s 
useful that Premiere Pro automatically modifies the timing of effects when 
necessary, it makes it even more important to check the transition before you 
move on.

Now let’s customize the transition.

8 In the Effect Controls panel timeline, hover the pointer over the middle part of 
the vertical black line that crosses all three layers (the two video clips and the 
transition effect between them). The line is the edit point between the two clips. 
If your pointer is correctly positioned, it will change to the red Rolling Edit tool.

This edit line is close to the left edge of the effect, so you might want to zoom in 
to the Effect Controls panel timeline to conveniently make adjustments.

In the Effect Controls panel, the Rolling Edit tool lets you reposition the timing 
of an edit between two clips by dragging the edit line.

9 Still in the Effect Controls panel, drag left and right with the Rolling Edit tool. As 
you do, you’re changing the timing of the cut. The Out point of the clip on the 
left of the edit and the In point of the clip on the right of the edit update in the 
Timeline panel when you release the drag. This is a form of trimming.

You’ll explore trimming and rolling edits in more detail in Lesson 8, “Editing 
Video—Advanced Techniques.”

10 Move the pointer over the transition to the left or right of the edit line in the 
Effect Controls panel, and the pointer changes to the Slide tool. If there is a blue 
line, it’s the time ruler playhead.

Tip: You can posi-
tion the start time of a 
dissolve asymmetrically 
by dragging it to a new 
position. This means 
you don’t have to settle 
for the Centered, Start 
At Cut, and End At Cut 
options. You can drag 
the position of a transi-
tion effect directly on 
the Timeline too.

Tip: You may need 
to move the playhead 
out of the way—earlier 
or later—to see the edit 
point between two clips 
in the Effect Controls 
panel timeline.
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Using the Slide tool changes the start and end points of the transition without 
changing its overall duration. Unlike using the Rolling Edit tool, moving the 
transition rectangle with the Slide tool does not change the edit point between 
the two sequence clips. Instead, it changes the timing of the transition effect.

11 Use the Slide tool to drag the transition rectangle left and right and compare 
the results.

Using a Morph Cut effect
Morph Cut is a special transition effect that aims to be invisible. It’s designed to help 
with “talking head” video interviews, where a single speaker looks in the direction of 
the camera. If your subject pauses a lot or there is inappropriate content in the foot-
age, you may want to remove a section of the interview.

This would normally produce a jump cut (when the image seems to jump suddenly 
from one piece of content to another), but with media that changes very little over 
time, and a little experimentation, the Morph Cut effect might yield an invisible 
transition that seamlessly hides what you have removed. Let’s try it.

1 Open the sequence Morph Cut. Play the beginning of the sequence.

This sequence has one clip, with a jump cut near the start. It’s a small jump cut 
but enough to jar the audience.

2 In the Effects panel, look in the Video Transitions > Dissolve group for the 
Morph Cut effect. Drag this effect to the join between the two clips.

The Morph Cut transition effect begins by analyzing the two clips. If the play-
head is over the transition effect, you’ll see a banner across the screen while the 
analysis takes place, but you can continue to work on your sequence without 
waiting.
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Depending on your media, you may achieve improved results with the Morph 
Cut transition effect by experimenting with different durations.

3 In the Timeline panel, double-click the Morph Cut transition effect to display the 
Set Transition Duration dialog box. Change the duration to 16 frames (you can 
double-click any transition effect to access this setting).

4 When the analysis is complete, press Return/Enter to render the effect (if your 
system requires it) and play a preview.

The result is not perfect, but it’s close, and it’s unlikely an audience will notice 
the join between the clips.

Dealing with inadequate head or tail handles
If you try to extend a transition for a clip that doesn’t have enough frames in the 
handle for the new duration of the effect, the transition still appears but has diago-
nal warning bars through it. This means Premiere Pro is using a freeze frame to 
extend the duration of the clip. The last available frame is held onscreen to complete 
the transition effect.

You can adjust the duration and position of the transition to resolve the issue.

1 Open the sequence called Handles.

2 Locate the edit between the two clips.

These two sequence clips have no heads or tails. You can tell this immediately 
because of the little triangles in the corners of the clips; a triangle indicates the 
first or last frame of the original clip.

3 Select the Ripple Edit tool  in the Tools panel, and use it to drag the right 
edge of the first clip to the left (begin dragging just to the left of the cut between 
the two clips). Drag to shorten the duration of the first clip to about 1:10, and 
then release. A tool tip appears while you trim to show the new clip duration.

The clip to the right of the edit point ripples (moves) left to close the gap. Notice 
that the little triangles at the end (the right edge) of the clip you just trimmed are 
no longer present.

Tip: The Morph 
Cut transition effect 
usually produces the 
best results with shorter 
durations.
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4 Drag the Cross Dissolve transition effect from the Effects panel onto the edit 
point between the two clips.

You’ll discover that you can drag the transition onto the right side of the edit 
but not the left. That’s because there’s no handle available at the beginning of 
the second clip to create a dissolve that overlaps the end of the first clip without 
using freeze frames.

5 Press the V key to select the Selection tool, or click to select the tool  in the 
Tools panel. In the Timeline panel, click the Cross Dissolve transition once to 
select it. You may need to zoom in to make it easier to select the transition.

6 In the Effect Controls panel, set the duration of the effect to 1:12.

The clip handle is not long enough to create this effect; the diagonal lines on the 
transition, both in the Effect Controls panel and in the Timeline panel, indicate 
Premiere Pro automatically added a freeze frame to fill the duration you set.

7 Play the transition to see the result.

8 In the Effect Controls panel, change the alignment of the transition to Center 
At Cut.

9 Drag the Timeline panel playhead slowly through the transition and watch 
the result.

• For the first half of the transition (up to the edit point), the B clip is a freeze 
frame, while the A clip continues to play.

• At the edit point, the A clip and the B clip start to play.

• After the edit, a short freeze frame is used.

There are several ways to fix this kind of issue.

• You can change the duration or timing of the transition effect.

Tip: If you can’t 
see the full handles 
in the Effect Controls 
panel timeline, use the 
navigator at the bottom 
to zoom out.
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• You can drag the edit in the Timeline panel using the Rolling Edit tool 
(click and hold the Ripple Edit tool in the Tools panel to access it) to change 
the timing of the transition in the Timeline panel. Be sure to drag the edit 
between the clips and not the transition effect. This won’t necessarily remove 
all the freeze frames, but it may improve the overall result.

• You can drag one side of the edit in the Timeline panel using the Ripple Edit 
tool to shorten a clip, increasing the length of the handle. Again, be sure to 
click the edit between the clips and not the effect icon.

You’ll learn more about the Rolling Edit and Ripple Edit tools in Lesson 8. For now, 
make sure you have the Selection tool selected.

Adding audio transition effects
Audio transitions can dramatically improve a sequence’s soundtrack by remov-
ing unwanted audio pops or abrupt edits. Audiences are usually much more 
aware of inconsistency in the soundtrack than they are of the overall quality of the 
soundtrack, and crossfade transitions can have a big impact in smoothing variation 
between clips.

Extending content with AI
Premiere Pro has new features added throughout the year, which are usually tested in the beta version before 
being added to the release version. At the time of writing, one such feature that is in beta is the Generative 
Extend tool. Features and functionality may change before release but the Generative Extend tool  allows you 
to extend clips by using generative AI to create additional frames that match the appearance, movement, and 
audio of your original media.

Use the tool in the same way that you would use the Ripple Edit tool or Selection tool to extend the In point or 
Out point for a clip by trimming (for more information about trimming, see Lesson 8). As with all generative AI 
tools, results may vary. If this feature is not available in your version of Premiere Pro you will need to install and 
use the Premiere Pro Beta (version 25.2 or above). To install the Beta version of Premiere Pro, use the Creative 
Cloud desktop app. Click Apps in the sidebar at left, then click Beta. Scroll down until you see Premiere Pro (Beta) 
and click Install. For further information, visit helpx.adobe.com/premiere-pro/using/generative-extend.html.

l Note: The Rolling 
Edit tool lets you move 
the transition earlier 
or later but does not 
change the overall 
length of the sequence 
because it extends one 
clip while shortening 
another.

http://helpx.adobe.com/premiere-pro/using/generative-extend.html
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Creating a crossfade
When you apply a fade or cross-
fade, the audio level adjustment 
over time is illustrated by a curve on the effect icon on the sequence clip.

There are three styles of crossfade.

• Constant Gain: The Constant Gain crossfade (as its name implies) transitions 
audio by using a constant audio gain (volume) adjustment between the clips. 
Although this transition can lead to a slight perceived dip in the audio level for 
the listener, some editors find it useful. It’s most useful in situations where you 
do not want much blending between two clips but rather more of a dip out and 
in between the clips—it’s perfect for music edits.

• Constant Power: This is the default audio transition. It creates a smooth, 
gradual transition between two audio clips. The Constant Power crossfade works 
in a similar way to a video dissolve. The outgoing clip fades out slowly at first 
and then faster toward the end of the clip. For the incoming clip, the opposite 
occurs—the audio level increases quickly at the start of the incoming clip and 
more slowly toward the end of the transition. This crossfade is useful in situa-
tions where you want to blend the audio between two clips, without a noticeable 
drop in level in the middle.

• Exponential Fade: The Exponential Fade transition creates a fade between clips. 
It uses a logarithmic curve to fade out and fade up audio. Some editors prefer the 
Exponential Fade transition when performing a single-sided transition (such as 
fading in a music clip from silence at the start or end of a program).

Applying audio transitions
There are several ways to apply an audio crossfade to a sequence. You can, of course, 
drag an audio transition effect just as you would a video transition effect, but there 
are also useful shortcuts to speed up the process.

Audio transitions have a default duration, measured in seconds or frames. You 
can change the default duration by choosing Premiere Pro > Settings > Timeline 
(macOS) or Edit > Preferences > Timeline (Windows).

Let’s take a look at the three methods for applying audio transitions.

1 Open the sequence called Audio, and switch to the Selection tool.

The sequence has several clips with audio.
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2 Play the sequence to review the contents.

3 Open the Audio Transitions > Crossfade group in the Effects panel.

4 Drag the Exponential Fade transition to the start of the first audio clip.

5 Right-click the right edge of the last clip in the sequence and choose Apply 
Default Transitions.

A default video transition and default audio transition are added to the end of 
the clip. Because the video and audio are linked, selecting one selects them both.

6 Drag one end of the audio transition you just created to extend the duration, and 
then listen to the result.

To polish the project, next you’ll add an opening Cross Dissolve transition effect 
to the video clip at the beginning of the sequence. Press Esc to deselect the tran-
sition effect you just adjusted.

7 Move the playhead near the beginning of the sequence, and press Command+D 
(macOS) or Ctrl+D (Windows) to add the default video transition. The default 
video transition is a Cross Dissolve.

You now have a fade from black at the beginning and a fade to black at the end. 
Now let’s add a series of short audio dissolves to smooth out the sound mix.

8 Ordinarily, making a marquee selection in the Timeline panel would select clips, 
but you can override this by holding a modifier key and select edits instead.

l Note: The selection of clips does not have to be contiguous in the Timeline panel. You can 
Shift-click clips to select individual clips in a sequence.

Using the Selection tool, while holding Command+Option (macOS) or Ctrl+Alt 
(Windows), drag a marquee selection over all of the audio edits between the 
clips on track Audio 1, being careful not to select any video clips—drag from 
below the audio clips to avoid accidentally selecting items on the video track.

Holding Command/Ctrl allows you to select edits rather than clips. Holding 
Option/Alt temporarily unlinks the audio clips from the video clips to isolate 
those edits while making a selection.

l Note: To add only 
an audio transition, 
hold Option (macOS) 
or Alt (Windows) when 
right-clicking to select 
only the edge of the 
audio clip.

Tip: When using 
keyboard shortcuts to 
apply transition effects, 
Premiere Pro uses track 
targeting or clip selec-
tion to work out where 
exactly the effects 
should be applied.
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9 Press Shift+D to apply the default transition effect to all selected clips. You exclu-
sively selected audio clips, so Premiere Pro knows to add only audio transition 
effects.

You could have pressed Shift+Command+D (macOS) or Shift+Ctrl+D 
(Windows), which is the shortcut to add an audio-only transition. This is useful 
if you have selected both video and audio clips and want to apply audio transi-
tion effects only.

Command+D (macOS) or Ctrl+D (Windows) applies the default video-only 
transition.

10 Deselect the transitions by clicking an empty area of the Timeline panel or by 
pressing Escape. Play the sequence to see and hear the changes you made.

It’s common for audio editors to add one-frame or two-frame audio transitions to 
every cut in a sequence to avoid jarring pops when an audio clip begins or ends. If 
you set the default duration for audio transitions to two frames, you can select mul-
tiple clips and then choose Sequence > Apply Audio Transition to quickly smooth 
your audio mix.

l Note: If you’d like more transition effects, check the Adobe website. Visit helpx.adobe.com/
premiere-pro/plug-ins.html. There, you’ll find several third-party effects to explore.

Working with fade handles
All audio clips have a fade handle at each end that you can use to apply and adjust 
fades and crossfades. To see the fade handles for a clip, hover the pointer over it or 
select the clip.

If a fade has been applied, the fade handle will appear on the transition effect icon, 
ready for you to drag and adjust the effect.

To set the duration and curve of a fade, drag a handle:

• Drag left or right to adjust the duration of a fade or crossfade.

• Drag up or down to adjust the curve of a fade or crossfade.

Fade handles provide a quick way to add precisely timed fades to clips.  

Now choose File > Close to close the current project. Click Yes to save the file if you 
are prompted.

Tip: You could 
choose Apply Audio 
Transition from the 
Sequence menu to add 
transitions exclusively 
to audio clips, but if you 
have already chosen 
audio-only clips, there’s 
no need, as the default 
transition option will 
have the same effect.

Tip: You can also 
right-click any of the 
selected edits and 
choose apply default 
transitions.

Fade handle

http://helpx.adobe.com/premiere-pro/plug-ins.html
http://helpx.adobe.com/premiere-pro/plug-ins.html
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Review questions
1 How can you apply the default transition to multiple clips in a sequence?

2 In the Effects panel, how can you locate a transition effect by name?

3 How do you replace one transition with another?

4 What are three ways to change the duration of a video transition effect?

5 What is an easy way to gradually increase the audio level at the beginning of a clip?

Review answers
1 Select the clips, and choose Sequence > Apply Default Transitions To Selection or press 

Shift+D.

2 Start typing the transition name in the search box in the Effects panel. As you type, 
Premiere Pro displays all effects and transitions (audio and video) that have that letter 
combination anywhere in their names. Type more letters to narrow your search.

3 Drag the replacement transition on top of the transition you’re rejecting. The new 
transition inherits the timing of the effect it replaces (but not other settings, like 
border colors).

4 Use the Selection tool to drag the edge of the transition icon in the Timeline, do the 
same thing in the A/B timeline display in the Effect Controls panel, or change the 
Duration value in the Effect Controls panel. You can also double-click the transi-
tion icon in the Timeline panel and change the Duration value in the dialog box that 
appears.

5 Apply an audio crossfade transition to the beginning of the clip or drag the clip fade 
handle to apply a fade.
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INDEX
5.1 audio, 50, 276
8-bit video, 338, 369
32-bit color effects, 338
180° video, 60, 160
360° video, 60, 160

A
A/B timeline display, 185, 195, 196
accelerated effects, 338
action-safe area, 55, 107, 442–443
adaptive audio tracks, 50
additive color, 385, 408
adjustment layers

applying effects using, 342–344, 361–363
creating distinctive looks using, 403–404

Adobe After Effects, 15, 16, 344–346, 460, 483
Adobe Audition, 15, 214, 294, 313, 329–330
Adobe Character Animator, 15
Adobe Color service, 436
Adobe Creative Cloud. See Creative Cloud
Adobe Dynamic Link, 15, 16, 345
Adobe Express, 14
Adobe Firefly, 15
Adobe Fonts, 435, 460
Adobe Illustrator, 15, 78–79
Adobe Media Encoder, 14, 15, 16, 470, 479–483
Adobe Photoshop. See Photoshop
Adobe Premiere Pro resources, 6–7
Adobe Premiere Rush, 15, 17
Adobe SRT option, 120
Adobe Stock, 284–286, 484
After Effects, 15, 16, 344–346, 460, 483
AI features. See Generative AI
aligning text, 439, 441–442
alpha channels, 408–410, 412

rendering only, 481
transparency adjustments, 417–418

amplitude, 283
anchor points, 244, 252, 253
animation

of clip size changes, 256–258
keyframe interpolation and, 258–261
toggling on and off, 245, 249, 257
See also Motion effect

Appearance preferences, 28
aspect ratios, 261–263, 473, 476
assembly edits, 142–143
audio, 12, 270–331

Adobe Stock, 284–286
characteristics of, 283–284

clarity improvements, 319–320
creative adjustments, 320
dialogue adjustments, 309–328
display format options, 54
dragging without video, 155–156
ducking applied to, 295–296
editing in Audition, 294, 329–330
effects for improving, 308–309, 321–328
Enhance Speech feature, 309, 318–319
export options for, 478, 479
gain adjustments, 291–292
hardware preferences, 2, 74
installing plug-ins for, 326
interface setup, 273–283
loudness options, 311–312
mix setting, 276–277
monitoring process, 282–283
noise reduction, 312, 314–317, 329–330
normalizing, 292–294
Pan and Balance controls, 290
recording voice-over, 80–82
repairing or cleaning up, 312–314, 329–330
retiming with Remix, 297–298
reverb reduction, 313, 317–318
samples and sample rate, 54, 278–280
speed changes and, 214, 216–217
split edits, 298–300
syncing with video, 112–113
track types, 48–50, 282
transitions, 201–204
volume adjustments, 287–294, 300–303, 320–321
waveforms, 280–282

audio channels, 109–112, 277
Audio Clip Mixer, 24, 274, 301–303
audio effects, 308–309, 321–328, 335

DeNoise effect, 315–317 
Notch Filter effect, 327–328
Parametric Equalizer effect, 308, 322–326
See also video effects

audio meters, 277–278, 325
Audio Mix setting, 276–277
Audio Track Mixer, 274
Audio workspace, 273–276
Audition, Adobe, 15, 214, 294, 313, 329–330
Auto Bezier interpolation, 259, 356
Auto Reframe effect, 261–264
Auto Save feature, 29, 58
automatic clip selection, 372
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masking, 423–426
media files vs., 64–65
merging, 112–113
moving, 173–177
naming/renaming, 100–101, 118, 124
nesting, 263
nudging, 175
playback speed, 104, 208, 210–217
playing, 102–104, 105–106
positioning, 248, 249–250
previewing, 71, 73
range selections, 121–124
rearranging, 175–177
removing, 177–180
replacing, 217–221
resizing, 254–256
rotating, 251–253
selecting, 169–172, 203, 372
source, 347–349
splitting, 172–173
subclips created from, 125–127
volume adjustments, 287–294, 300–303

closed captions, 461, 462–463
codecs, 45, 476–478
collaboration, 484–485
color balance. See white balance
color correction, 12–13, 366–405

color grading vs., 371, 388
Color workspace for, 371–372, 392
Comparison view for, 388–390
distinctive looks through, 403–404
effects related to, 391–393
exposure problems and, 393–397
guidelines for checking, 398
Lumetri Color panel for, 373–378, 398–403
Lumetri Scopes panel for, 378–388
matching colors for, 390–391
Ultra Key effect and, 423
white balance and, 397–403
workflow for, 370–388

color grading, 371, 388
color management, 48
Color Picker, 433
color spaces, 55, 380
color wheels, 375, 398–400
Color workspace, 371–372, 392
colors

label, 68, 99–100
matching, 390–391
primary and secondary, 385
text, 436–437

comment markers, 161
Comparison view, 388–390

B
backdrop for text, 447
background noise removal, 329–330
backups, file, 29
Balance control, 290
Basic 3D effect, 267–268
Bezier interpolation, 259, 356
bins, 12, 22, 93–101

creating new, 94–95
customizing, 103
filtering content in, 91–92
managing media in, 95–96
naming/renaming, 95
organizing clips in, 40
Project panel and, 77, 97
Search Bin creation, 92
view options for, 97–99

bit depth, 47, 338
Black & White effect, 339–340
blend modes, 413

alpha channels and, 418
combining tracks using, 416–417
video effects and, 344

bonus material, 4
Brightness & Contrast effect, 350, 395–396
Button Editor, 108–109, 137, 275, 326, 458

C
captions, 461–466

closed, 461, 462–463
converting to graphics, 465–466
creating new, 464–465
open, 461

Captions and Graphics workspace, 430
chapter markers, 161
chroma key effects, 411, 418–423
Clamp Signal option, 380, 383
Clarity options, 319–320
Clip Name effect, 361–363
clipboard, 177
clips, 10, 36

closing, 104
conforming, 42–43, 131
copying/pasting, 177
disabling, 180
dragging, 174
finding, 90–93
grouping, 173
handles of, 186–187, 199–201
importing, 70–75
label colors for, 99–100
linking and unlinking, 173
markers added to, 164–165
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Directional Blur effect, 340–341
disabling clips, 180
Display Color Management feature, 369, 398
Drag Audio Only icon, 108, 155, 280
Drag Video Only icon, 108, 155
dragging clips, 174
drop shadows

motion effects and, 264, 265–267
text styles and, 448

drop zone, 26, 27
dropped frames, 51
ducking audio, 295–296
duration

audio transition, 202
displays showing, 90, 107
pre-roll and post-roll, 236
setting for still images, 145
speed changes related to, 213–215, 217
video transition, 192, 196, 200

Dynamic Link, 15, 16, 345
dynamic trimming, 235–236

E
Ease In/Out interpolation, 260–261, 356
Edit Original option, 79
editing

multicamera, 13
nonlinear, 10
text-based, 221–225
touchscreen, 104
See also audio; video editing

Editing workspace, 21, 118
edits

assembly, 142–143
delete and ripple delete, 179–180
extract, 19, 169, 179
four-point, 142, 208–210
insert, 139–140, 154–155, 167–168
lift, 169, 178–179
overwrite, 138–139, 168
replace, 218–219
ripple, 227–228
rolling, 229
slide, 230–231
slip, 229–230
split, 298–300
three-point, 141

Effect Controls panel, 24
audio effects, 309, 316, 321–328
Brightness & Contrast controls, 350
Filter Properties menu, 258
Motion effect controls, 243–246

compositing, 406–427
alpha channels used in, 417–418
blend modes used in, 416–417
color keying greenscreen shots for, 418–423
Opacity effect used in, 413–417
partially masking clips for, 423–426
preprocessing footage for, 412
shooting videos for, 411
terminology related to, 412–413

conforming process, 42–43, 82, 131
Constant Gain crossfade, 202
Constant Power crossfade, 193–194, 202
Continuous Bezier interpolation, 259, 356
contrast, text, 436–437
Copy Media option, 40
copying/pasting

clip segments, 177
transition effects, 194
video effects, 341

creative adjustments
for audio, 320
for color, 374

Creative Cloud
components overview, 14–15
Library assets, 58

credits, 430, 458–459
Crop controls, 244
Cross Dissolve effect, 188–189, 194
crossfade transitions, 202
curves adjustments, 374, 396, 401–403
cuts, 184, 186

D
decibel (dB) scale, 278, 312
DeEss audio option, 312
default settings, 16, 37, 64
DeHum audio option, 312, 313–314, 328
delete and ripple delete edits, 179–180
DeNoise effect, 315–317
DeReverb effect, 317–318
dialogue adjustments, 309–328

audio effects, 321–328
clarity options, 319–320
Creative Reverb effect, 320
Enhance Speech feature, 309, 318–319
loudness options, 311–312
noise reduction, 312, 314–317
repair or cleanup features, 312–314
reverb reduction, 313, 317–318
volume settings, 320–321
See also voice-overs

Dip to White transition, 189–190
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F
fade handles, 204
fader control, 302
file formats

choosing for export, 473
supported by Premiere Pro, 10–11, 70, 485

files
lesson, 3, 4–5, 18
project, 17, 18, 29, 36, 143
See also media files

Fill color swatch, 433
Fill Frame option, 254, 256
Filter Bin Content box, 91–92
Final Practice project, 486–487
Find dialog box, 92–93
finding assets

Effects panel for, 337, 339
Project panel for, 90–93
Timeline panel for, 165–166

Fit Clip dialog box, 208–209, 210
Fit To Frame option, 254, 256, 257
fixed effects, 242, 334–336, 341
Flash cue points, 161
flicker reduction, 244
folders, importing, 80
fonts

factors for choosing, 436
resizing in Project panel, 28, 97
warning about missing, 460

four-point editing, 142, 208–210
frame rate, 37, 42, 211, 212–213
frame size, 42, 47
frames, 37

dropped, 51
exporting single, 472–473
stepping through, 106

Freeform view, 75, 89, 97, 143–144
freeze frames, 199–201
frequency, audio, 283
FX badges, 180, 210, 348, 414

G
gain adjustments, 291–292
gamma options, 370
gaps, finding/removing, 168–169
Gaussian Blur effect, 343–344
Generative AI, 10

Adobe Firefly technology, 15
Enhance Speech feature, 309, 318–319
Generative Extend tool, 201

GPU acceleration, 3, 13, 47, 52–53, 338

Properties panel and, 244, 432
transition options, 185, 191, 195–198
video effects, 339, 340, 348–349
volume adjustments, 288–289

effects. See audio effects; video effects
Effects panel, 24, 184, 265, 336–337

audio effects, 308–309, 321–328
color-adjustment effects, 392–393
finding effects in, 188, 337, 339, 392
video effects, 188–191, 336–339

Effects workspace, 334, 395
Ellipse tool, 431, 452
Enhance Speech feature, 309, 318–319
Essential Sound panel, 308–322

clarity adjustments, 319–320
creative adjustments, 320
dialogue adjustments, 309–322
ducking options, 295–296
Effect Controls panel and, 316
Enhance Speech feature, 309, 318–319
improving audio with, 308–309
loudness options, 311–312
noise reduction, 312, 314–317
presets used in, 310, 322
reverb reduction, 313, 317–318
stock audio clips in, 284–286
volume adjustments, 320–321

Exponential Fade transition, 202
Export Settings dialog box, 482–483
exporting, 468–485, 488–489

aspect ratios for, 476
codecs chosen for, 476–478
collaborating and, 484–485
configuration settings for, 480
effects applied during, 478–479
file formats for, 473, 485
full-quality media files, 473–479
markers, 165
overview of options for, 471–472
presets for, 471, 477, 480
queuing media files for, 480–482
quick option for, 25, 470–471
single frames, 472–473
to social media, 483–484
source range for, 475

exposure fixes, 393–397
overexposed images, 397
underexposed images, 395–397

extract edits, 19, 169, 179
eyedroppers, 400, 402, 403, 420, 433–434
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folders and subfolders, 80
Illustrator files, 78–79
ingest settings for, 59, 68
layered Photoshop files, 75–77, 95
media files, 64–75
proxy file creation and, 69
still image files, 75–79

In and Out points
clearing or removing, 134–135
options for setting, 107, 134, 179, 223
Source Monitor, 119, 121, 122–124
three-point editing with, 141
Timeline panel, 133–135

indexed MPEGs, 82
Info panel, 25
ingest settings, 59, 68
insert edits, 139–140, 154–155, 167–168
installing Premiere Pro, 2
instances, clip, 100
interpolation methods, 259–260, 354, 356
interpretation, 109

audio channel, 110–112
video footage, 113–114, 119, 212

J
J-cut edits, 298–300
jump cuts, 186

K
kerning text, 437–438
Key Color eyedropper, 420
keyboard shortcuts, 21, 29–31

for adding markers, 164
for In and Out points, 134–135, 179
for nudging clips, 175
for ripple edits, 228
for toggling snapping, 174
for trimming, 237
for video playback, 103–104
for volume adjustments, 288

Keyboard Shortcuts dialog box, 193
keyframes, 13, 242, 258–261

adding to effects, 352–354
clip vs. track, 301
Ease In/Out controls for, 260–261
interpolation methods for, 259–260, 354, 356
opacity adjustments with, 415
Scale control and, 257
Velocity graph for, 354, 355–356
video effects using, 352–356
volume adjustments with, 300–301

keying process, 408, 411, 412, 413
keywords, 460

graphics
adding image files to, 454–455
configuring, 431–435
creating in Photoshop, 451
importing into projects, 75–79
layered Photoshop files as, 75–78
Motion Graphics templates for, 59, 459–461
saving Source Graphics, 450
single-layer files as, 75
upgrading captions to, 465–466

Graphics Templates panel, 430
greenscreen, 413

color keying shots made with, 418–423
shooting videos using, 411

Grid view, 39, 71
grouping

clips, 173
panels, 22

guides and rulers, 456–458

H
H.264 codec, 471, 478
Hand tool, 105
handles

audio fade, 204
clip, 186–187, 199–201

hard drives
finding media files on, 96–97
typical setup for, 58

HDR video, 55, 369, 377, 380
headers, track, 81, 137
History panel, 25
Hold interpolation, 259, 356
Home screen, 16–17, 21
hover scrubbing, 102
HSL Secondary settings, 375, 400
Hue Saturation Curves controls, 401–403

I
Icon view, 20, 75, 77, 97, 98, 99, 144
Illustrator, Adobe, 15, 78–79
image stabilization, 360–361
images. See still images
immersive (VR) video, 60, 160
Import command, 67–68
Import Into Project option, 481
Import mode

adding clips using, 70–72
Favorite Location button, 74
Media Browser panel vs., 65–67

importing, 64–80
customizing media cache for, 82–83
file formats supported for, 70
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masking
composited clips, 423–426
text used for, 455–456
video effects, 349–352

Match Frame command, 255
Match Sequence Preview Settings option, 474
matching colors, 390–391
mattes, 412–413

creating custom, 423–424
generating and adjusting, 422

Media Browser panel, 23
adding clips using, 72–75
browsing inside projects with, 67
folder imports using, 80
Import mode vs., 65–67
navigation features, 74

media cache, 82–83
Media Encoder, 14, 15, 16, 470, 479–483
media files

clips vs., 64–65
compressed, 411
exporting, 14, 473–479
guidelines for working with, 69–70
importing, 64–75
linking, 18
locating on drives, 96–97
managing in bins, 95–96
organizing, 88–101
proxy, 59, 69

Mercury Playback Engine, 13, 52–53, 157
merging clips, 112–113
metadata, 13, 103, 109, 478, 481
Monitor panels. See Program Monitor; Source 

Monitor
mono audio, 50, 276
Morph Cut effect, 198–199
Mosaic effect, 357–358
Motion effect, 241, 242–258, 335

adjusting, 242–248
animating size changes, 256–258
options for working with, 243–248
position changes, 243, 248, 249–250
reusing settings for, 250–251
rotation option, 243, 251–253
scale settings, 243, 254–256

Motion Graphics templates (MOGRTs), 59, 459–461
motion paths, 260, 355
moving clips, 173–177
MPEG4 file format, 478
multicamera editing, 13
multichannel audio, 276
music tracks. See audio
Mute button, 283

L
label colors, 68, 99–100
layers

Photoshop, 75–77, 78, 95
Properties panel, 432, 454
See also adjustment layers

L-cut edits, 300
leading, text, 440–441
Learning workspace, 25
Lens Flare effect, 352–356
lesson files, 3, 4–5, 18
letterboxing, 255
Libraries panel, 24, 58
lift edits, 169, 178–179
Linear interpolation, 259, 356
Link Media dialog box, 18
Linked Selection option, 170, 172, 173, 193
linking/unlinking clips, 173
List view, 21, 39, 75, 77, 97, 98
Locate File dialog box, 18
locking

guides, 457
tracks, 166–168

looped playback, 109, 123, 236, 326
loudness adjustments, 311–312, 479
Lumetri Color effect, 348–349, 376, 394
Lumetri Color panel, 371, 373–378

example of using, 377–378
Lumetri Color presets, 392–393, 404
match color feature, 390–391
sections and controls, 373–375
Settings tab, 376–377
white balance adjustments, 398–403

Lumetri Look effects, 348, 479
Lumetri Scopes panel, 371, 372, 378–388

RGB parade, 387–388
waveform display, 380–383
YUV vectorscope, 384–387

LUT files, 373–374

M
Maintain Audio Pitch option, 214
margins, safe, 107–108, 442–443
Mark In/Out buttons, 107, 121, 122, 134
Marker dialog box, 163
markers, 161–165

adding, 121, 162, 164
clip, 164–165
explanation of, 161
exporting, 165
sequence, 161–164
types of, 161

Markers panel, 162, 164, 165
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pillarboxing, 256
pixel aspect ratio, 113–114
playback

controls for, 105–106
looping, 109, 123, 236, 326
Mercury Playback Engine and, 52–53
methods for performing, 102–104, 105–106
performance settings, 52–53
real-time, 51, 52
rendered, 52
resolution for, 106, 157–160
speed controls for, 104, 208, 210–217
VR video, 160

plug-ins, 326
point text, 443, 444–446
Polygon tool, 431, 452, 453
Position control, 243, 248, 249–250
poster frames, 99
preferences

introduction to setting, 28–29
resetting to default, 16, 37, 64

Premiere Pro Beta, 201
Premiere Rush, 15, 17
presets

audio effect, 310, 322
built-in, 357–358
file export, 471, 477, 480
Lumetri Color, 392–393, 404
saving, 358–359
sequence, 44–45, 47
video effect, 341, 357–359

previews
exporting files of, 481
thumbnail, 71, 73

primary and secondary colors, 385
Program Monitor, 23, 150–156

adding clips with, 152–154
Comparison view, 388–390
customizing display of, 108–109
insert editing with, 154–155
overview of, 150–151
rulers and guides, 456–458
selecting layers in, 434
Source Monitor compared to, 151
trimming in, 231–236
See also Source Monitor

project files, 17, 18, 29, 36, 143
Project panel, 22, 88–93

bins and, 77, 97
customizing, 89
editing video from, 123
features overview, 88–89
filtering bin content in, 91–92

N
narration. See voice-overs
nesting

clips, 263
sequences, 129

network-based storage, 58
noise reduction, 312, 314–317, 329–330
nonlinear editors (NLEs), 10
normalizing audio, 292–294, 479
Notch Filter effect, 327–328
nudging clips, 175
numeric keypad, 122

O
online content, 3–4
opacity, 409, 413, 415, 418
Opacity effect, 335, 413–417
open captions, 461
Optical Flow option, 217
optimizing performance, 2–3
organizing media, 88–101

bins used for, 40, 93–101
Project panel for, 88–93

overcranking technique, 211
overexposed images, 397
overlay options, 108, 153, 479
overwrite edits, 138–139, 168

P
Pan control, 290, 302
panel menu, 25, 28
panel tab, 28
panels, 21

active, 120
grouping, 22
monitor, 23
overview of, 22–25
resizing, 26, 27

paragraph text, 443, 446–447
Parametric Equalizer effect, 308, 322–326
Paste Attributes dialog box, 251
Paused Resolution setting, 159–160
pauses, removing, 224
peak level, 312
Pen tool, 300, 431, 451, 452, 454
performance

optimizing, 2–3
playback, 52–53

phase, audio, 283
photomontage, 193–194
Photoshop, 15

creating graphics or titles in, 451
importing layered files from, 75–77, 95
working with files from, 78
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Rotation control, 243, 251–253, 445
rubber bands, 287, 289, 300, 414, 415
rulers and guides, 456–458
rumble reduction, 312

S
safe margins display, 107–108, 442–443
saving

automated, 29, 58
presets, 358–359
workspaces, 28

Scale controls, 243, 254–256, 257, 445, 476
Scene Edit Detection, 127
scopes, 372, 379
scratch disks, 55–59
scrubbing, 81, 135, 289
SDR Conform option, 479
Search Bin creation, 92
second monitor, 120
segmentation markers, 161
Selection tool, 24, 129, 170, 172, 226, 227, 229
Send To Media Encoder option, 481, 482
sequences, 10, 22, 36–37, 129

adding clips to, 152–154
audio tracks in, 48–50
configuring settings for, 37, 45–48
conforming clips in, 42–43, 131
creating, 12, 40, 129–130
extract edits in, 169, 179
finding/removing gaps in, 168–169
insert edits in, 139–140, 154–155, 167–168
lift edits in, 178–179
markers added to, 161–164
matching settings in, 43, 474–475
nesting, 129
opening in Timeline, 130
overwrite edits in, 138–139, 168
presets for, 44–45, 47
rearranging clips in, 175–177
removing clips from, 177–180
rendering parts of, 195
selecting clips in, 170–171, 203
setting up, 42–50

shadow effects. See drop shadows
shapes, creating, 451–454
shot types, 124
single-layer image files, 75
single-sided transitions, 188–189
slide edits, 230–231
Slide tool, 197–198, 230
slip edits, 229–230
Slip tool, 230
slow motion effect, 210–212

finding assets in, 90–93
label colors in, 99–100
renaming items in, 101
sorting items in, 242
viewing clips in, 74–75

Project Settings dialog box, 38, 50
project-based storage setup, 56, 57
projects

browsing, 67
closing multiple, 466
creating new, 17, 37–42
managing, 13, 18
opening, 17, 18, 67

Properties panel, 24, 244, 290, 335, 431–435
ProRes 422 HQ codec, 478
proxy media, 59, 69, 481

Q
queuing exports, 480–482
Quick Export option, 25, 470–471

R
Rate Stretch tool, 216–217
Razor tool, 172
real-time playback, 51, 52
recording voice-overs, 80–82
Rectangle tool, 431, 452, 453
regular trim, 226–227, 231
Remix tool, 297–298
rendering

effects in sequences, 52, 363
maximum quality, 47, 480
parts of sequences, 195
real-time playback vs., 52
Render And Replace option, 363–364

replace edits, 218–219
Replace Footage command, 220–221
Reset button, 245, 257
Reset To Saved Layout command, 21
resolution, playback, 106, 157–160
resources, Premiere Pro, 6–7
Reverb effect, 320
reverb reduction, 313, 317–318
Reverse Speed option, 214, 215
reviewing footage, 102–109
RGB color, 78, 369
RGB parade, 387–388
ripple delete edits, 180
Ripple Edit tool, 199, 201, 227–228
ripple edits, 227–228, 231
rolling credits, 458–459
Rolling Edit tool, 197, 201, 229, 299
rolling edits, 229, 232, 299
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temporal interpolation, 260
text

aligning, 439, 441–442
captions as, 461–466
colors for, 436–437
contrast needed for, 436–437
fonts for, 436
kerning, 437–438
leading for, 440–441
masking with, 455–456
paragraph, 443, 446–447
point, 443, 444–446
rolling, 458–459
rotating, 445
safe margins for, 442–443
strokes added to, 446, 447
styles for, 447–449
tracking, 439
See also titles

Text panel, 221, 222–225, 431, 446
Text-Based Editing, 221–225

adding content using, 224–225
removing content using, 221–224
transcription feature, 221, 222, 225

three-point editing, 141
thumbnails

playing video in, 102–104
previewing clips from, 71, 73
resizing, 39, 71, 73, 99, 102, 143

Time Interpolation option, 481
Time Remapping effect, 335
time rulers, 19, 106, 123, 135–136
Time Tuner option, 479
timecode, 54, 107, 122, 123, 154, 386, 481
Timecode panel, 136
Timeline panel, 22, 127–137

colored lines on, 51, 195
facts about, 127–129
features illustration, 128
finding clips in, 165–166
In and Out points, 133–135
locking tracks in, 166–168
opening sequences in, 130
showing clip names and labels in, 68
targeting tracks in, 132–133
time rulers, 19, 135–136
track headers, 137

titles
appearance options for, 447–448
creating for video, 13, 443–447
Photoshop for creating, 451
safe margins for, 442–443
stylizing text for, 447–449

snapping feature, 20, 174, 217, 297, 457
social media uploads, 483–484
Solo button, 277, 283
Sort Icons menu, 98
sound editing. See audio
source clip effects, 347–349
Source Graphics, 450
Source Monitor, 23, 119–127

controls overview, 121
customizing display of, 108–109
In and Out points, 119, 121, 122–124
opening clips in, 120
playback controls, 105–106
Program Monitor compared to, 151
timecode display, 107
Zoom Level menu, 104–105
See also Program Monitor

Source Range controls, 475
source track indicators, 132–133
spatial interpolation, 260
special effects. See audio effects; video effects
speed controls, 104, 208, 210–217
SpeedLooks effects, 404
spill suppression, 422
split edits, 298–300
splitting clips, 172–173
standard audio tracks, 50, 282
stereo audio, 276
still images

adding to graphics, 454–455
exporting single frames as, 472–473
importing into projects, 75–79
setting duration for, 145
See also graphics

stock audio clips, 284–286
storage setups, 55–59
storyboards, 142–145
strokes, text, 446, 447
styles, text, 447–449
subclips, 125–127
subtractive color, 385
sync locks, 166–168
synchronizing

audio with video, 112–113
replace edits, 219

system requirements, 1, 3
system-based storage setup, 56, 57

T
Team Projects, 17
television screens, 107–108, 369, 398
templates

Motion Graphics, 59, 459–461
project type, 38
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U
Ultra Key effect, 420–423
underexposed images, 395–397

V
vector graphics, 78, 252
Vector Motion effect, 252–253
vectorscope display, 384–387
Velocity graph, 354, 355–356
video

8-bit, 369
display format options, 54
dragging without audio, 155–156
interpreting footage from, 113–114, 119, 212
reviewing, 102–109
supported files types, 70
syncing audio with, 112–113
transition effects, 188–195
VR, 60, 160
See also audio

video editing
advanced techniques of, 206–239
extract edits, 169, 179
four-point, 142, 208–210
insert edits, 139–140, 154–155, 167–168
lift edits, 178–179
moving clips, 173–177
opening clips, 120
overwrite edits, 138–139
Program Monitor for, 150–156
Project panel for, 123
removing clips, 177–180
replacing clips/footage, 217–221
second monitor used in, 120
selecting parts of clips for, 121–124
sequences used in, 129–131
Source Monitor for, 119–127
speed/duration changes, 210–217
storage setups for, 55–59
storyboards for, 142–145
subclip creation, 125–127
three-point, 141
Timeline panel for, 127–137
tracks used in, 131–133
transitions used in, 182–205
trimming as, 226–237

video effects, 332–365
adjustment layers for, 342–344, 361–363
After Effects used for, 344–346
applying to clips, 339–341
Clip Name effect, 361–363
color-adjustment, 391–393, 403–404

typography essentials for, 435–443
See also text

title-safe area, 55, 107, 442–443
Toggle Animation button, 245, 249, 257
Toggle Track Output button, 77, 252, 445
tone mapping, 377, 478
Tools panel, 24, 129, 431
touchscreen editing, 104
track headers, 81, 137
track locks, 168
Track Matte Key effect, 425–426
tracking

motion, 349, 352
text, 439

tracks, 12, 23
audio, 48–50, 282
explained, 131–132
locking, 166–168
selecting multiple clips on, 171–172
targeting, 132–133

transcoding files, 59, 472
transcription feature, 40, 221, 222, 225, 464–465
Transform effect, 265–267
transitions, 182–205

audio, 201–204
copying/pasting, 194
customizing, 195–198
duration of, 192, 196, 200, 202
explanation of, 185
handles and, 186–187, 199–201, 204
knowing when to use, 185–186
Morph Cut effect, 198–199
multiple-clip, 193–194
setting default, 193–194, 203–204
single-sided, 188–189
two-clip, 189–192
video, 188–195

transparency, 409, 410, 417–418, 445
trimming, 13–14, 197, 226–237

keyboard shortcuts for, 237
modifier keys to refine, 235
performing dynamic, 235–236
Program Monitor options for, 231–236
regular trim process, 226–227
ripple edits for, 227–228
rolling edits for, 229
slide edits for, 230–231
slip edits for, 229–230

Type tool, 431, 438, 443, 446
typography essentials, 435–443
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W
Warp Stabilizer effect, 360–361
watch folders, 483
waveform display

audio waveforms, 280–282
Lumetri Scopes panel, 380–383

Web Edition of book, 3, 4
web link markers, 161
white balance, 397–403

curves for adjusting, 401–403
Lumetri color wheels for, 398–400
secondary color adjustment of, 400–401

workflow
color adjustment, 370–388
standard digital video, 11–12

workspaces, 16, 21–28, 485–486
Audio workspace, 273–276
Captions and Graphics workspace, 430
Color workspace, 371–372, 392
customizing and saving, 25–28
Editing workspace, 21, 118
Effects workspace, 334, 395
Learning workspace, 25
Text-Based Editing workspace, 222

Workspaces menu, 22, 42, 184, 485Y
YC waveform display, 381
YUV color, 339, 369
YUV effects, 339
YUV vectorscope, 384–387

Z
Zoom control, 97, 98, 99, 102, 143
Zoom Level menu, 104–105
zooming in/out, 139, 189

copying/pasting, 341
Effects panel, 336–339
exporting media with, 478–479
finding, 188, 337, 339, 392
fixed, 242, 334–336, 341
frequently used, 360–363
keyframing, 352–356
masking and tracking, 349–352
Motion effect, 242–258
presets for, 341, 357–359
real-time playback of, 51, 52
removing from video, 341
rendering sequences with, 52, 363
source clip, 347–349
types of, 337–339
Video Limiter effect, 392, 479
Warp Stabilizer effect, 360–361
See also audio effects

Video Limiter effect, 392, 479
vignette effect, 375
voice-overs

adjusting audio for, 309–328
recording, 80–82
See also dialogue adjustments

volume adjustments, 287–294
Audio Clip Mixer, 301–303
Effect Controls panel, 288–289
Essential Sound panel, 320–321
gain adjustments, 291–292
keyboard shortcuts for, 288
keyframes for making, 300–301
loudness options, 311–312
normalizing audio, 292–294
overall clip levels, 287
Properties panel for, 290

VR video, 60, 160
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